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1 Introduction

Large regional multi-layer MODFlOW models tend to have large cell sizes, in
the order of several thousand feet on a side. While perhaps still adequate to
describe flow in deeper formations, the cells are often too large to meaningfully
represent the complex groundwater flow patterns in shallower formations, which
result from detailed surface water and groundwater interactions.

The analytic element method, in contrast, is uniquely suitable for represent-
ing surface water and groundwater interactions, even on a large regional scale
since it does not employ a computational grid or element network. The idea
then is to replace the upper MODFLOW layer or layers in which direct surface
water and groundwater interactions take place by the analytic element model
GFLOW. In so doing, the coarse MODFLOW grid no longer interferes with
an accurate representation of the shallow flow regime, while full advantage can
be taken of GFLOW’s conjunctive surface water and groundwater flow solu-
tions. The hybrid modeling approach described here is particularly suitable for
modeling well-stream interactions, which are difficult to do in a large regional
MODFLOW model with cells that are, for instance, a mile on a side.

Below some technical details of the implementation of this coupling are pre-
sented.

2 Method

We distinguish between two coupling methods:

• Sequential coupling.

• Iterative coupling.

The sequential (non-iterative) coupling provides an approximate, but often sat-
isfactory representation of the groundwater flow regime in the upper layer(s) by
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the analytic element model GFLOW. An iterative coupling procedure may offer
a refinement on the sequentially coupled models and may be desirable for cer-
tain cases, but also significantly increases the computational effort. It has been
found, however, that when the transmissivity in the lower MODFLOW layers
varies the head interpolation becomes inaccurate and the iterative procedure
may fail to produce an improvement. In fact, it is likely to degrade the solution.
Consequently, the iterative solution process is not activated in the officially re-
leased GFLOW GUI. A more detailed investigation of the performance of these
coupling strategies is found in (Abrams et al. 2015; Haitjema et al. 2010).

2.1 Sequential coupling summary

1. Produce a (multi-layer) MODFLOW solution for the complete regional
flow model.

2. Design a GFLOW model that represents the upper layer(s) of the MOD-
FLOW model.

3. Provide the GFLOW model with a grid of cells that is conform the MOD-
FLOW grid. These cells will be used to transfer recharge at the aquifer
top and leakage at the GFLOW aquifer bottom from the MODFLOW
model.

4. Solve the GFLOW model with the recharge and leakage values obtained
from the previous two steps.

The resulting GFLOW model will include the recharge and leakage distribution
from the original MODFLOW model, but more accurately represent surface
water and groundwater interactions due to the gridless (analytic) nature of the
analytic element method employed by GFLOW. However, when the combined
transmissivities of the lower layers (those not included in the GFLOW model)
dominate, the leakage values at the bottom of the GFLOW model become rel-
atively large. Since these leakage values are obtained from the original coarse
MODFLOW model they are approximate and as they become more significant
tend to reduce the accuracy of the GFLOW solution (Haitjema et al. 2010;
Abrams et al. 2015).

A more detailed step by step procedure for this sequential coupling using
the GFLOW and GW Vistas GUIs is provided in section 4.

2.2 Representing leakage

The leakage grid in GFLOW is identical to the MODFLOW grid so that leak-
age rates can be transferred directly from MODFLOW to GFLOW. While the
GFLOW model provides a detailed (analytic) solution to flow in the upper
flow domain, which exhibits detailed surface water-groundwater interactions,
its leakage representation is still that of the (coarse) MODFLOW grid. Thus
there is no detailed leakage distribution near surface waters and wells.

2



Haitjema et al. (2001) found that MODFLOW cell dimensions should not
exceed a “characteristic leakage length” λ [L] in order to keep errors in leakage
below a few percent. The characteristic leakage length λ for a two aquifer
system, separated by an aquitard, is defined as (Hemker 1984; Bruggeman 1999):

λ =

√
T1T2c

T1 + T2
(1)

where T1 and T2 are the transmissivities [L2/T ] of the two aquifers and where
c [T ] is the resistance of the separating aquitard:

c =
d

kv
(2)

where d [L] is the thickness of the aquitard and where kv [L/T ] is the vertical
hydraulic conductivity of the aquitard. Expression (2) may also be interpreted
as the vertical resistance to flow between model layers, like is done in MOD-
FLOW by a “VCONT” parameter, which is the inverse of a resistance. In that
case the distance d is a representative distance for vertical flow, for instance,
the distance between the centers of the two model layers. The vertical hydraulic
conductivity kv is than the vertical hydraulic conductivity in the model layers.
Haitjema et al. (2001) studied the flow from a canal to a well in an aquifer un-
derneath a lake or wetland with constant water level. Interpreting the wetland
or lake as an adjacent aquifer with an infinite transmissivity reduces (1) to:

λ =
√
Tc (3)

where T is the transmissivity of the aquifer and c the resistance to flow between
the aquifer and the overlying lake or wetland. As a general conclusion they
found that MODFLOW cell dimensions should not exceed λ in order to limit
errors in leakage and thus errors in flow from the canal to the well. In fact,
only when the cell dimensions were as small as 0.1λ were errors in leakage truly
negligible. These observations may also be understood from one-dimensional or
two-dimensional radial symmetric solutions to flow in a leaky aquifer (Brugge-
man 1999). It appears that 95% of the leakage due to a linear feature( e.g. a
long canal) or a well occurs within a distance of 3λ or 4λ from the canal or well,
respectively. Clearly, to represent that leakage fairly an adequate grid resolution
is needed at that scale.

Leakage in multi-aquifer systems

For multi-aquifer settings with more than one aquitard there exist multiple
“lambda” (λ) values. Regretfully, these lambda values cannot be associated
with individual aquitards and, therefore, their values cannot be used to assess
the leakage distribution though individual aquitards. All that may be said is
that the leakage through all aquitards due to a canal or well becomes small
beyond 3 or 4 times the largest lambda value in the system, respectively.
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Figure 1: Accessing the “Leakage from MODFLOW” Dialog.

3 GUI functions and files from MODFLOW

The sequentially coupled GFLOW - MODFLOW solutions are managed from
the GFLOW graphical user interface (GUI). The GUI contains a menu called
“Grid” used to manage both the “MODFLOW extract” process and the Hy-
brid GFLOW - MODFLOW modeling via the “Leakage from MODFLOW”
submenu, see Figure 1.

The “Show Grid Dialog” option in Figure 1 opens the dialog “Leakage from
MODFLOW” shown in Figure 2. The “File” menu offers the options “Open
Grid” and “Remove Grid” (not shown in Figure 2). When clicking on “Open
Grid” the “Open MODFLOW Grid” dialog is shown. If present in your work-
ing directory, the file “basename.del” will be shown. “basename” is the DOS file
name used for communications between the GUI and the Solver and is set on
the Project>Project Settings dialog. In the example used in this document the
basename is “hybrid.” The basename.del file is a MODFLOW file that defines
the MODFLOW grid to be used in GFLOW. The basename.del file does gen-
erally not contain georeferencing information, but you can supply that on the
“General” tab of the “Leakage from MODFLOW” dialog, see Figure 2. How-
ever, it is better to edit the file basename.del (e.g. using Notepad) and add the

4



Figure 2: The “General” tab of the “Leakage from MODFLOW” dialog.
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x and y coordinates of the lower left corner of the grid to the bottom of the file,
see the file format for hybrid.del in the Appendix.

The coupling process requires the following files to be present in the working
directory, which is the folder where the GFLOW project file (*.gfl) resides:

• basename.del contains the grid design parameters. This file is read by GUI
and Solver.

• basename.vlk contains an array of leakage values from the lowest MOD-
FLOW layer that is represented in GFLOW to the MODFLOW layer
below it. Thus now from the GFLOW model layer into the underlying
MODFLOW layer. This file is read by GUI and Solver.

• basename.rta contains an array of recharge values applied to the top of
Layer 1 in the MODFLOW model. It will also be applied to the top of the
GFLOW model. Note: If not present the Solver will assume no recharge
input from MODFLOW, but any recharge defined in the GFLOW GUI
by use of inhomogeneity domains will still apply. This file is read by the
Solver only.

The file formats are presented in the Appendix for files with the basename
“hybrid.”

The “Tracking” tab of the “Leakage from MODFLOW” dialog is shown in
Figure 3. By moving the mouse over the MODFLOW grid, cell-specific data are
shown on the “Tracking” tab fields. The “X Position” and “Y Position” (under
“Grid”) are relative to the lower left corner of the MODFLOW grid, while the
coordinates displayed above it are the “world coordinates,” see Figure 3.
Important: The cell-by-cell MODFLOW recharge rate (in the basename.rta
file) is added by the Solver to whatever recharge rate is already defined in the
GFLOW model by the GUI. Thus for the recharge rate at the aquifer top to be
the same in the MODFLOW and GFLOW models no other recharge should be
defined in the GFLOW GUI!

4 Step by Step Sequential Coupling Procedure

1. Produce a MODFLOW solution for the complete regional flow model.
The grid must be aligned with the horizontal and vertical coordinates of
a cartesian world coordinate system. e.g. UTM or State Plane. It works
best to zone the aquifer properties in MODFLOW in a manner that can
easily be duplicated in GFLOW. To the degree possible, include all surface
water features that will also be included in the GFLOW representation of
the upper model.

2. Design a GFLOW model that represents the upper layer(s) of the MOD-
FLOW model. Make sure that all layers in MODFLOW that are in direct
contact with surface waters are represented in the GFLOW model. If this
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Figure 3: The “Tracking” tab of the “Leakage from MODFLOW” dialog.

is indeed more than one MODFLOW model layer, they will be represented
as a single Dupuit-Forchheimer aquifer in GFLOW. Hence, these MOD-
FLOW layers should be well connected to each other without significant
resistance to vertical flow. Note: If there is substantial vertical resistance
to flow, for instance due to acquitards, calculate λ values for these upper
layers (see section 2.2) and make sure that they are, in general, at least
an order of magnitude smaller than the distance between the surface wa-
ters. Alternatively, one can also verify that the head differences between
the MODFLOW layers to be included in GFLOW are small. If not, the
GFLOW model will generate heads that are a weighted average of the
heads in the various (upper) layers; weighted according to the transmis-
sivities of these layers.

3. Provide the GFLOW model with a grid of cells that is conform the MOD-
FLOW grid. These cells will be used to model recharge at the aquifer
top and leakage at the aquifer bottom. In the GFLOW GUI use the
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Project>Project Settings to define a unique “Base Filename (DOS)” which
from here on will be referred to as the “basename.” Create a basename.del
file that defines the MODFLOW grid to be included in GFLOW, see the
Appendix for the file format. Make sure this (one layer) grid is identical
to the grid layers in your MODFLOW model (same horizontal cell sizes).

Note: It is possible to only represent a sub-grid of the regional MODFLOW
model in GFLOW. In that case the cell-by-cell leakage rates and recharge
rates referred to below must belong to that same sub-grid.

4. Create a file basename.rta that contains the cell-by-cell recharge values
used for the top MODFLOW layer. This file may be created using the
GW Vistas GUI by selecting the View as Matrix option on the Plot menu
after having selected these recharge rates as the boundary condition to
be displayed on the Plot menu. In this matrix view, select an appropri-
ate formatting and copy the matrix to a spreadsheet or to an editor (e.g.
Notepad). Remove the header of column numbers and the first column
with row numbers. Write the matrix of recharge rates to an ASCII file
with the name basename.rta. Note: If no basename.rta file exists in the
working directory then the Solver will assume zero recharge rates in the
MODFLOW model. Of course, any recharge defined in GFLOW inhomo-
geneities will still be included in the calculations.

5. Follow this same procedure for exporting the leakages between the upper
layer(s) to be represented in GFLOW and the layer immediately below
it by selecting in the Plot menu the vertical flows to be displayed. Make
sure in the View as Matrix menu to select the proper layer to get the flows
into the layer(s) that will be represented by GFLOW. Save the matrix of
leakage values to the file basename.vlk which may be done using the same
steps as outlined above for the recharge rates (step 4).

6. Make sure that the above created files are in the GFLOW working di-
rectory for your project. This is the folder where the project file *.gfl
resides (in this example: hybrid demo.gfl). In the GFLOW GUI go to
Grid>Leakage from MODFLOW>Show Grid Dialog. On the “Leakage
from MODFLOW” dialog click on File>Open Grid. You should see the
file basename.del in the file dialog box. Open the file. If you included the
x and y coordinates of the lower left corner of the grid at the bottom of
the basename.del file (see the hybrid.del file in the Appendix) you will see
these displayed on the “General” tab of the “Leakage from MODFLOW”
dialog (see Fig. 2). If not, type in these coordinates and click “Update.”
Click on the “Tracking” tab and by moving the cursor over the cells check
that all properties are there.

7. Assuming that all other GFLOW data are correctly entered, click on the
calculator icon to schedule the GFLOW Solver (will run in a DOS box).
The resulting solution will include the recharge and the leakage obtained
from the MODFLOW model.
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Note: The grid of recharge rates from MODFLOW, basename.rta, is only
read by the Solver, not by the GUI. Hence, you can only inspect the recharge
rates in GFLOW after a solution has been generated (step 7 above) and by
placing the cursor on the location where you seek the recharge rate and then
perform a shift left-click to bring up the “Model Results” message box. The
recharge rate is listed near the middle of the data list. The recharge reported
here is the sum of any recharge that may have been introduced in the GUI
via an inhomogeneity domain and the recharge rate in the MODFLOW cell in
which the cursor was placed. In general, for consistency with the MODFLOW
model, no recharge rates other than in the MODFLOW grid cells should be
specified. Thus none of the inhomogeneities in GFLOW should have the box
“Change recharge rate from default” checked!

The GFLOW solution obtained in this manner will be approximate since
the leakage rates of the (coarse regional) MODFLOW model are approximate.
The approximation has been found to be quite acceptable in most cases except
perhaps under circumstances where the lower MODFLOW layers, those not rep-
resented by GFLOW, have a combined transmissivity that is significantly higher
(by several factors) than the combined transmissivity of the layers represented
by GFLOW. More details on the performance of the hybrid model are found in
(Abrams 2015).

Modeling well-stream interactions

To model the impact of wells on streams, say to assess the magnitude and extent
of streamflow reduction, it is necessary to create a hybrid model of the aquifer
system without and with the well present. Thus two sets of cell-by-cell leakages
must be transferred from MODFLOW to GFLOW, one whereby the well is
absent and one set whereby the well is present in MODFLOW. These leakages
must then be used in two different GFLOW models whereby the well is also
absent and present, respectively. The two different GFLOW models can then
be used to inspect streamflow differences and plot drawdowns.
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Appendix: File Formats

Below are example files to illustrate their file format. In some cases repetitive
lines are replaced by “. . . .” The files are for a test case of a well at the center
of a 40 by 40 cell MODFLOW grid, but this case is not provided with the
program. All text between parentheses are explanations that are not included
in the files themselves.

file: hybrid.dat (Solver input file generated by the GUI)

* Written by GFLOW for Windows 2.2.1

error error.log

yes

message message.log

yes

echo echo.log

yes

picture off

quit

bfname hybrid

modelorigin 2206233.41 15586965.1 2

title hybrid

aquifer

base 4.00000E+02

permeability 2.0000000E+01

thickness 2.0000000E+02

porosity 1.0000000E-01

reference 2.6477658E+05 2.6478237E+05 7.0116129E+02

quit

layout

window -26894.28 -16361.92 74575.92 52970.03

quit

linesink

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

6.620000E+00 3.497833E+04 0.000000E+00 3.028509E+04 7.00000E+02 LS_000727_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

0.000000E+00 3.026523E+04 0.000000E+00 2.530308E+04 7.00000E+02 LS_000728_0101

head
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resistance 0

width 0.000000E+00 1

depth 0.000000E+00

0.000000E+00 2.528984E+04 0.000000E+00 2.026915E+04 7.00000E+02 LS_000729_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

0.000000E+00 2.024929E+04 6.620000E+00 1.528817E+04 7.00000E+02 LS_000730_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

6.620000E+00 1.527494E+04 6.620000E+00 1.027410E+04 7.00000E+02 LS_000731_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

6.620000E+00 1.025217E+04 1.324000E+01 4.795630E+03 7.00000E+02 LS_000732_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

1.986000E+01 4.762530E+03 0.000000E+00 1.030000E+00 7.00000E+02 LS_000733_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

1.324000E+01 0.000000E+00 4.752810E+03 1.324000E+01 7.00000E+02 LS_000734_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

4.792530E+03 6.620000E+00 9.746400E+03 6.620000E+00 7.00000E+02 LS_000735_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

9.759640E+03 0.000000E+00 1.509497E+04 2.648000E+01 7.00000E+02 LS_000736_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

1.513578E+04 2.529000E+01 1.976612E+04 2.529000E+01 7.00000E+02 LS_000737_0101

head

resistance 0
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width 0.000000E+00 1

depth 0.000000E+00

1.981054E+04 1.324000E+01 2.490095E+04 1.324000E+01 7.00000E+02 LS_000738_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

2.494770E+04 2.529000E+01 3.012705E+04 1.986000E+01 7.00000E+02 LS_000739_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

3.018440E+04 2.529000E+01 3.494027E+04 1.324000E+01 7.00000E+02 LS_000740_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

2.896000E+01 3.496323E+04 4.761080E+03 3.496323E+04 7.00000E+02 LS_000741_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

4.814040E+03 3.496323E+04 9.757990E+03 3.497647E+04 7.00000E+02 LS_000742_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

9.791080E+03 3.496985E+04 1.474744E+04 3.496323E+04 7.00000E+02 LS_000743_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

1.480702E+04 3.496985E+04 1.975180E+04 3.496323E+04 7.00000E+02 LS_000744_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

1.979813E+04 3.496323E+04 2.496632E+04 3.496323E+04 7.00000E+02 LS_000745_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

2.500603E+04 3.496323E+04 2.994915E+04 3.496323E+04 7.00000E+02 LS_000746_0101

head

resistance 0

width 0.000000E+00 1

12



depth 0.000000E+00

2.999549E+04 3.496323E+04 3.491379E+04 3.496323E+04 7.00000E+02 LS_000747_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

3.494689E+04 3.496985E+04 3.494689E+04 3.026544E+04 7.00000E+02 LS_000748_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

3.495351E+04 3.021249E+04 3.494689E+04 2.520793E+04 7.00000E+02 LS_000749_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

3.496013E+04 2.516159E+04 3.496013E+04 2.025198E+04 7.00000E+02 LS_000750_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

3.496675E+04 2.022550E+04 3.496013E+04 1.522095E+04 7.00000E+02 LS_000751_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

3.496675E+04 1.518123E+04 3.494689E+04 1.064893E+04 7.00000E+02 LS_000752_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

3.495351E+04 1.062907E+04 3.495351E+04 5.247200E+03 7.00000E+02 LS_000753_0101

head

resistance 0

width 0.000000E+00 1

depth 0.000000E+00

3.496675E+04 5.220720E+03 3.496013E+04 3.971000E+01 7.00000E+02 LS_000754_0101

head

resistance 1.763917E+00

width 1.500000E+01 1

depth 1.000000E+01

6.757060E+03 1.794031E+04 7.483310E+03 1.935203E+04 7.19597E+02 LS_000755_0051

7.483310E+03 1.935203E+04 8.232700E+03 2.075553E+04 7.18791E+02 LS_000755_0101

8.232700E+03 2.075553E+04 1.064324E+04 2.144063E+04 7.17751E+02 LS_000755_0151

1.064324E+04 2.144063E+04 1.248426E+04 2.190376E+04 7.16634E+02 LS_000755_0201

1.248426E+04 2.190376E+04 1.508065E+04 2.185406E+04 7.15493E+02 LS_000755_0251
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1.508065E+04 2.185406E+04 1.748598E+04 2.166198E+04 7.14222E+02 LS_000755_0301

1.748598E+04 2.166198E+04 1.915977E+04 2.091696E+04 7.13145E+02 LS_000755_0326

1.915977E+04 2.091696E+04 2.103395E+04 2.157844E+04 7.12176E+02 LS_000755_0351

2.103395E+04 2.157844E+04 2.248319E+04 2.151011E+04 7.11304E+02 LS_000755_0376

2.248319E+04 2.151011E+04 2.404944E+04 2.248329E+04 7.10468E+02 LS_000755_0401

head

resistance 1.763917E+00

width 1.500000E+01 1

depth 1.000000E+01

1.056055E+04 6.199080E+03 1.248986E+04 6.199080E+03 7.21548E+02 LS_000756_0051

1.248986E+04 6.199080E+03 1.408844E+04 6.254200E+03 7.20721E+02 LS_000756_0101

1.408844E+04 6.254200E+03 1.568701E+04 7.466910E+03 7.19876E+02 LS_000756_0201

1.568701E+04 7.466910E+03 1.750607E+04 9.010360E+03 7.18847E+02 LS_000756_0226

1.750607E+04 9.010360E+03 1.987637E+04 8.844990E+03 7.17731E+02 LS_000756_0251

1.987637E+04 8.844990E+03 2.147494E+04 9.616720E+03 7.16758E+02 LS_000756_0276

2.147494E+04 9.616720E+03 2.246566E+04 1.108882E+04 7.15926E+02 LS_000756_0301

2.246566E+04 1.108882E+04 2.340425E+04 1.242800E+04 7.15127E+02 LS_000756_0351

2.340425E+04 1.242800E+04 2.379011E+04 1.562514E+04 7.13990E+02 LS_000756_0401

2.379011E+04 1.562514E+04 2.411925E+04 1.748776E+04 7.12792E+02 LS_000756_0501

2.411925E+04 1.748776E+04 2.390036E+04 1.964913E+04 7.11839E+02 LS_000756_0601

2.390036E+04 1.964913E+04 2.405744E+04 2.248329E+04 7.10665E+02 LS_000756_0701

head

resistance 1.763917E+00

width 4.700000E+01 1

depth 1.000000E+01

2.405629E+04 2.249586E+04 2.500282E+04 2.461021E+04 7.08980E+02 LS_000757_0101

2.500282E+04 2.461021E+04 2.560918E+04 2.604342E+04 7.07275E+02 LS_000757_0301

2.560918E+04 2.604342E+04 2.638090E+04 2.747662E+04 7.05873E+02 LS_000757_0401

2.638090E+04 2.747662E+04 2.753849E+04 2.951617E+04 7.04123E+02 LS_000757_0501

2.753849E+04 2.951617E+04 2.853070E+04 3.100450E+04 7.02303E+02 LS_000757_0601

2.853070E+04 3.100450E+04 2.940914E+04 3.248390E+04 7.00758E+02 LS_000757_0701

quit

leakage (This command makes the Solver include the Leakage from MODFLOW)

origin -2350.41000000015 -2460.09999999963

quit

layout

window -26894.28 -16361.92 74575.92 52970.03

quit

time 0

solve 30 3 1 1

save hybrid

y

time 0

extract

file hybrid
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y

well discharge

well head

ppwell discharge

ppwell head

Theis well

linesink discharge

linesink head

inhomogeneity

quit

grid

window -26894.28 -16361.92 74575.92 52970.03

dotmap off

horizontalpoints 80

plot heads

go

save hybrid

y

surfer hybrid

y

quit

trace

picture off

file hybrid

y

time 3650

step 491.579030023864

go

quit

stop

file: hybrid.del

7 ...(number of rows)

5714 ..(height of the cells in row 1)

5714 ..(height of the cells in row 2)

5714 ..(height of the cells in row 3)

5714 ..(height of the cells in row 4)

5714 ..(height of the cells in row 5)

5714 ..(height of the cells in row 6)

5714 ..(height of the cells in row 7)

8 ...(number of columns)

5000 ..(width of the cells in column 1)

5000 ..(width of the cells in column 2)

5000 ..(width of the cells in column 3)

5000 ..(width of the cells in column 4)
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5000 ..(width of the cells in column 5)

5000 ..(width of the cells in column 6)

5000 ..(width of the cells in column 7)

5000 ..(width of the cells in column 8)

2203883 ...(X-coordinate of the lower-left corner of the grid in world coordinates)

15584505 ...(Y-coordinate of the lower-left corner of the grid in world coordinates)

file hybrid.vlk (containing cell-by-cell leakages)

0.000000000000000E+00 0.000000000000000E+00 0.000000000000000E+00

0.000000000000000E+00 0.000000000000000E+00 0.000000000000000E+00

0.000000000000000E+00 0.000000000000000E+00 ...(row 1)

0.000000000000000E+00 2.507515440976488E-03 2.660565789135689E-03

2.720754589488521E-03 2.716079297600277E-03 4.918693188006090E-04

3.097917282885222E-03 0.000000000000000E+00 ...(row 2)

0.000000000000000E+00 2.421764901068415E-03 -2.100747776078358E-03

-3.896573220271630E-03 -3.163913686349994E-03 1.179318435661254E-03

2.573168306622857E-03 0.000000000000000E+00 ...(row 3)

0.000000000000000E+00 2.075526482809555E-03 4.750195929213012E-03

5.772680122509183E-03 5.620805593552664E-03 2.816617820536916E-03

2.070578530495633E-03 0.000000000000000E+00 ...(row 4)

0.000000000000000E+00 2.430273522934196E-03 2.919889229907431E-03

2.377718403029333E-03 -1.167561686142696E-03 1.489259056565748E-03

1.881474961749453E-03 0.000000000000000E+00 ...(row 5)

0.000000000000000E+00 1.040659992248662E-04 -2.737262264488966E-03

-6.136200699793848E-03 6.303836810405135E-04 1.573031551952371E-03

-9.823841780295809E-05 0.000000000000000E+00 ...(row 6)

0.000000000000000E+00 0.000000000000000E+00 0.000000000000000E+00

0.000000000000000E+00 0.000000000000000E+00 0.000000000000000E+00

0.000000000000000E+00 0.000000000000000E+00 ...(row 7)

file hybrid.rta (containing cell-by-cell recharge values)

0.00E+00 0.00E+00 0.00E+00 0.00E+00 0.00E+00 0.00E+00 0.00E+00 0.00E+00

0.00E+00 5.00E-03 5.00E-03 5.00E-03 5.00E-03 5.00E-03 5.00E-03 0.00E+00

0.00E+00 5.00E-03 5.00E-03 5.00E-03 5.00E-03 5.00E-03 5.00E-03 0.00E+00

0.00E+00 5.00E-03 5.00E-03 5.00E-03 5.00E-03 5.00E-03 5.00E-03 0.00E+00

0.00E+00 5.00E-03 5.00E-03 5.00E-03 5.00E-03 5.00E-03 5.00E-03 0.00E+00

0.00E+00 5.00E-03 5.00E-03 5.00E-03 5.00E-03 5.00E-03 5.00E-03 0.00E+00

0.00E+00 0.00E+00 0.00E+00 0.00E+00 0.00E+00 0.00E+00 0.00E+00 0.00E+00
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